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Nakladnik:  

hǘǾƻǊŜƴƻ ŘǊǳǑǘǾƻ Ȋŀ ǊŀȊƳƧŜƴǳ ƛŘŜƧŀ (ODRAZI), Zagreb 

ISBN: 

978-953-56758-2-2 

Mjesto i godina izdavanja:  

Zagreb, 2011.  

 

Autorsko pravo:  

Slobodno kopirajte, tiskajte i dalje distribuirajte cijelu ili dio ove ǇǳōƭƛƪŀŎƛƧŜΣ ǳƪƭƧǳőǳƧǳŏƛ ƛ ǳ 

ǎǾǊƘǳ ƻǊƎŀƴƛȊƛǊŀƴƛƘ ǑƪƻƭƻǾŀƴƧŀΣ ōƛƭƻ ǳ ƧŀǾƴƛƳ ƛƭƛ ǳ ǇǊƛǾŀǘƴƛƳ ŜŘǳƪŀŎƛƧǎƪƛƳ ƻǊƎŀƴƛȊŀŎƛƧŀƳŀΣ ŀƭƛ 

ƛǎƪƭƧǳőƛǾƻ ǳ ƴŜƪƻƳŜǊŎƛƧŀƭƴŜ ǎǾǊƘŜ όŘŀƪƭŜ ōŜȊ ƴŀǇƭŀǘŜ ƪǊŀƧƴƧƛƳ ƪƻǊƛǎƴƛŎƛƳŀκŎŀƳŀ Ȋŀ ƪƻǊƛǑǘŜƴƧŜ 

ǇǳōƭƛƪŀŎƛƧŜύ ǘŜ ǳȊ ƴŀǾƻŚŜƴƧŜ ƛȊǾƻǊŀ όƛȊvor: www.ITdesk.info - ǇǊƻƧŜƪǘ ǊŀőǳƴŀƭƴŜ Ŝ-edukacije 

ǎŀ ǎƭƻōƻŘƴƛƳ ǇǊƛǎǘǳǇƻƳύΦ LȊǾŜŘŜƴƛ όŘŜǊƛǾƛǊŀƴƛύ ǊŀŘƻǾƛ ƴƛǎǳ ŘƻǇǳǑǘŜƴƛ ōŜȊ ǇǊŜǘƘƻŘƴƻƎ 

odobrenja nositelja autorskih prava (udruga hǘǾƻǊŜƴƻ ŘǊǳǑǘǾƻ Ȋŀ ǊŀȊƳƧŜƴǳ ƛŘŜƧŀ - ODRAZI). 

Yƻƴǘŀƪǘ Ȋŀ ǘǊŀȌŜƴƧŜ ŘƻȊǾƻƭŜΥ info@ITdesk.info    

http://www.itdesk.info/
mailto:info@ITdesk.info
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Predgovor 

5ŀƴŀǑƴƧŜ ŘǊǳǑǘǾƻ ƻōƛƭƧŜȌŜƴƻ je naglim rastom i razvojem 

ƛƴŦƻǊƳŀŎƛƧǎƪŜ ǘŜƘƴƻƭƻƎƛƧŜ όL¢ύΣ Ǒǘƻ ƧŜ ǊŜȊǳƭǘƛǊŀƭƻ ǾŜƭƛƪƻƳ ƻǾƛǎƴƻǑŏǳ 

ŘǊǳǑǘǾŀΣ ǳ ǑƛǊŜƳ ǎƳƛǎƭǳΣ ƻ znanju i kompetencijama osobe u IT 

ǇƻŘǊǳőƧǳΦ L ǇǊŜƳŘŀ ǘŀ ovisnost raste iz dana u dan, ljudsko pravo na 

obrazovanje i informacije ƴƛƧŜ ǇǊƻǑƛǊŜƴƻ ƛ ƴŀ L¢ ǇƻŘǊǳőƧŜΦ tƻƧŀǾili su 

ǎŜ ǇǊƻōƭŜƳƛ ƪƻƧƛ ǳǘƧŜőǳ ƴŀ ŘǊǳǑǘǾƻ u cjelini, koji stvaraju prepreke i 

udaljavaju ljude od glavnog razloga i motivacije za napredak, od 

prilikeΦ 5ŀƴŀǎΣ ōƛǘƛ Ǌŀőǳƴŀƭƴƻ ƴŜǇƛǎƳŜƴŀ ƻǎƻōŀΣ Ȋƴŀőƛ ōƛǘƛ ƻǎƻōŀ ƪƻƧŀ 

ƴƛƧŜ ǳ ƳƻƎǳŏƴƻǎǘƛ ǎǳŘƧŜƭƻǾŀǘƛ ǳ ƳƻŘŜǊƴƻƳ ŘǊǳǑǘǾǳΣ ƻǎƻōŀ ōŜȊ ǇǊƛƭƛƪŜ, 

ƛ ǳƴŀǘƻő ǇǊƛȊƴŀǘƻƧ ƴŜƻǇƘƻŘƴƻǎǘƛ ƛ korisnosti inklǳȊƛǾƴŜ ƛƴŦƻǊƳŀǘƛőƪŜ 

pismenosti, od strane Europske komisije, UNESCO-a, OECD-a i ostalih 

relevantnih institucijaΣ ƧƻǑ ǳǾƛƧŜƪ postoje grupe ljudƛ ǎŀ ƻǘŜȌŀƴƛƳ 

ǇǊƛǎǘǳǇƻƳ ƻǎƴƻǾƴƻƧ ǊŀőǳƴŀƭƴƻƧ naobrazbi (npr. osobe s invaliditetom, 

osobe s poǘŜǑƪƻŏŀƳŀ ǳ ǳőŜƴƧǳΣ ǊŀŘƴƛŎŜκƛ ƳƛƎǊŀƴǘƛΣ ƴŜȊŀǇƻǎƭŜƴŜ 

ƻǎƻōŜΣ ƻǎƻōŜ ƪƻƧŜ ȌƛǾŜ ƴŀ ǳŘŀƭƧŜƴƛƳ ƳƧŜǎǘƛƳŀ ƎŘƧŜ nemaju pristup 

Ǌŀőǳƴŀlnoj edukaciji). 

 

Ove skripte, zajedno sa ostalim materijalom objavljenim na stranici 

ITdesk.info, ǇǊŜŘǎǘŀǾƭƧŀƧǳ ƴŀǑ ŘƻǇǊƛƴƻǎ ǊŜŀƭƛȊŀciji I promociji ljudskog 

ǇǊŀǾŀ ƴŀ ŜŘǳƪŀŎƛƧǳ ƛ ƛƴŦƻǊƳŀŎƛƧŜ ǳ L¢ ǇƻŘǊǳőƧǳ. bŀŘŀƳƻ ǎŜ Řŀ ŏŜ ±ŀƳ 

ƻǾŀ ŜŘǳƪŀŎƛƧŀ ǇƻƳƻŏƛ u savladavanju ƻǎƴƻǾƴƛƘ ǊŀőǳƴŀƭƴƛƘ ǾƧŜǑǘƛƴŀ i 

sa tom nadom ȌŜƭƛƳƻ Vam da ƴŀǳőƛǘŜ Ǒǘƻ ǾƛǑŜ i tako postanete 

aktivni/a őƭŀƴκƛŎŀ modernog IT druǑǘǾŀ. 

 

LǎƪǊŜƴƻ ±ŀǑƛ, 

ITdesk.info team 
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MICROSOFT WORD 2010 BETA ς ELEMENTI {¦29[WA 

 
1. Gumbi za manipulaciju prozorom ς minimiziranje, maksimiziranje, zatvaranje prozora 

2. Naslovna traka ς ime dokumenta, ekstenzija (.docx) te ime programa 

3. Kartice / tabs 

o Datoteka / File 

o tƻőŜǘƴŀ κ IƻƳŜ 

o Umetni / Insert 

o Izgled stranice / Page Layout 

o Reference / References 

o tƻǑǘŀ κ aŀƛƭƛƴƎǎ 

o Prikaz / Review 

o Pogled / View 

4. Trake s alatima / Toolbars 

o neke naredbe skrivene, imaju strelicu pokraj za otvaranje dodatnih opcija  

o ȊŀǎƛǾƭƧŜƴŜ ƴŀǊŜŘōŜ ǎŜ ƴŜ ƳƻƎǳ ǘǊŜƴǳǘƴƻ ƛȊǾǊǑƛǘƛ όƴŀ ǎƭƛŎƛΥ /ƘŀƴƎŜ [ƛǎǘ [ŜǾŜƭύ 

o ƴŀǊŜŘōŜ ǎ ǘǊƛ ǘƻőƪŜ ƛƳŀƧǳ ǎƭƛƧŜŘ ŘŀƭƧƴƧƛƘ ƴŀǊŜŘōƛ όƴŀ ǎƭƛŎƛΥ 5ŜŦƛƴŜ bŜǿ .ǳƭƭŜǘΦΦΦύ 

 kartice i alatne trake zajedno se nazivaju vrpca (ribbon) 

5. wŀŘƴŀ ǇƻǾǊǑƛƴŀ ς papir, ovdje upisujemo tekst, ubacujemo objekt 

6. ¢ƻőƪŀ ǳƳŜǘŀƴƧŀΣ ƳƧŜǎǘƻ ƎŘƧŜ ǘǊŜǇŜǊƛ ƪǳǊǎƻǊ 

7. ¢ǊŀƪŜ Ȋŀ ƘƻǊƛȊƻƴǘŀƭƴǳ ƛ ǾŜǊǘƛƪŀƭƴǳ ƴŀǾƛƎŀŎƛƧǳ όƪƭƛȊŀőƛύ 

o dvostruka strelica gore/dolje prebacuje pogled za jednu ǎǘǊŀƴƛŎǳ ǾƛǑŜκƳŀƴƧŜ 

8. Statusna traka 

o ǇǊƛƪŀȊǳƧŜ ǇƻŘŀǘƪŜ ƻ ǘǊŜƴǳǘƴƻƳ ǇƻƭƻȌŀƧǳ ǘƻőƪŜ ǳƳŜǘŀƴƧŀ ƴŀ ǊŀŘƴƻƧ ǇƻǾǊǑƛƴƛ ƛ ǎǘŀƴƧŜ ƴŜƪƛƘ 

specijalnih funkcija Microsoft Word-a 

9. Ravnala - ƘƻǊƛȊƻƴǘŀƭƴƻ ƛ ǾŜǊǘƛƪŀƭƴƻ ǊŀǾƴŀƭƻΣ ƛȊƴŀŘ ƛ ǎ ƭƛƧŜǾŜ ǎǘǊŀƴŜ ǎǳőŜƭƧŀ 

o ōƛƧŜƭƻ ǇƻŘǊǳőƧŜ ƻȊƴŀőŀǾŀ ǇǊƻǎǘƻǊ Ȋŀ ǇƛǎŀƴƧŜΣ ǎƛǾƻ ǇƻŘǊǳőƧŜ ǇǊŜŘǎǘŀǾƭƧŀ ƳŀǊƎƛƴŜ 
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h½b!2!±!bW9 ¢9Y{¢! 

 

tǊƛƧŜ ǳǊŜŚƛǾŀƴƧŀ ǘŜƪǎǘŀ ǇƻǘǊŜōƴƻ ƧŜ ƻȊƴŀőƛǘƛ Řƛƻ ǘŜƪǎǘŀ ƴŀŘ ƪƻƧƛƳ ŏŜ ǎŜ ƛȊǾǊǑƛǘƛ ƻŘǊŜŚŜƴƻ ƻōƭƛƪƻǾŀƴƧŜ. 

hȊƴŀőŀǾŀƴƧŜ ǇǊƻƛȊǾƻƭƧƴƻƎ ǘŜƪǎǘŀΥ 

 ǇǊƛǘƛǎƴŜƳƻ ƛ ȊŀŘǊȌƛƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀΣ ǇǊƛƧŜŚŜƳƻ ƳƛǑŜƳ ƻŘ ǇƻőŜǘƪŀ Řƻ ƪǊŀƧŀ ǘŜƪǎǘŀ ƪƻƧƛ 

ȌŜƭƛƳƻ ƻȊƴŀőƛǘƛ ǘŜ ƻǘǇǳǎǘƛƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ 

 ǇƻǎǘŀǾƭƧŀƴƧŜƳ ǘƻőƪŜ ǳƳŜǘŀƴƧŀ ƴŀ ƳƧŜǎǘǳ ǇƻőŜǘƪŀ ƻȊƴŀőŀǾŀƴƧŀΣ ǇǊƛǘƛǎƪƻƳ ƴŀ ǘƛǇƪǳ {ƘƛŦǘ te 

ǇǊƛǘƛǎƴǳǘƛ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ ƴŀ ƳƧŜǎǘǳ ȌŜƭƧŜƴƻƎ ȊŀǾǊǑŜǘƪŀ ƻȊƴŀőŀǾŀƴƧŀ 

OzƴŀőŀǾŀƴƧŜ ƧŜŘƴŜ ǊƛƧŜőƛΥ ŘǾƻǎǘǊǳƪƛ ǇǊƛǘƛǎŀƪ ƭƛƧŜǾŜ ǘƛǇƪŜ ƳƛǑŀ ƴŀ ǊƛƧŜő. 

hȊƴŀőŀǾŀƴƧŜ ƧŜŘƴŜ ǊŜőŜƴƛŎŜΥ ǇǊƛǘƛǎƴŜƳƻ ǘƛǇƪǳ /ǘǊƭ ƛ ǇǊƛǘƛǎŀƪ ƭƛƧŜǾŜ ǘƛǇƪŜ ƳƛǑŀ ōƛƭƻ ƎŘƧŜ ǳ ȌŜƭƧŜƴƻƧ 

ǊŜőŜƴƛŎƛ. 

hȊƴŀőŀǾŀƴƧŜ ƧŜŘƴƻƎ ǊŜǘƪŀΥ ǳ ǇǊƻǎǘƻǊǳ ƳŀǊƎƛƴŜ ƭƛƧŜǾƻ ƻŘ ǊŜǘƪŀ ǇǊƛǘƛǎƴŜƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ όǇƻƪŀȊƛǾŀő 

mora biti u obliku bijele strelice). 

hȊƴŀőŀǾŀƴƧŜ ǾƛǑŜ ǊŜŘŀƪŀΥ ǳ ǇǊƻǎǘƻǊǳ ƳŀǊƎƛƴŜ ƭƛƧŜǾƻ ƻŘ ǊŜŘŀƪŀΣ ǇǊƛǘƛǎƴŜƳƻ ƛ ȊŀŘǊȌƛƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ 

ǘŜ ǎŜ ǇƻƳƛőŜƳƻ ƎƻǊŜ ƛƭƛ ŘƻƭƧŜ ǇǊŜƪƻ ǊŜŘŀƪŀ ƪƻƧŜ ȌŜƭƛƳƻ ƻȊƴŀőƛǘƛ ǘŜ ƻǘǇǳǎǘƛƳƻ ǘƛǇƪǳ ƳƛǑŀ. 

hȊƴŀőŀǾŀƴƧŜ ƴŜǎǳǎƧŜŘƴƛƘ ǊŜŘŀƪŀΥ ǳ ǇǊƻǎǘƻǊǳ ƭƛƧŜǾŜ ƳŀǊƎƛƴŜ ǇǊƛǘƛǎƴŜƳƻ ǘƛǇƪǳ Ctrl + pritisnemo lijevu 

ǘƛǇƪǳ ƳƛǑŀ ƴŀ ȌŜƭƧŜƴŜ ǊŜǘƪŜΦ  

hȊƴŀőŀǾŀƴƧŜ ƧŜŘƴƻƎ ƻŘƭƻƳƪŀΥ - u prostoru margine lijevo od odlomka, dvostruki pritisak lijeve tipke, 

ili trostruki pritisak liƧŜǾŜ ǘƛǇƪŜ ƳƛǑŀ ǳƴǳǘŀǊ ƻŘƭƻƳƪŀ. 

hȊƴŀőŀǾŀƴƧŜ ŎƛƧŜƭƻƎ ŘƻƪǳƳŜƴǘŀΥ ǘǊƻǎǘǊǳƪƛ ǇǊƛǘƛǎŀƪ ƭƛƧŜǾŜ ǘƛǇƪŜ ƳƛǑŀ ǳ ǇǊƻǎǘƻǊǳ ƭƛƧŜǾŜ ƳŀǊƎƛƴŜΣ ƛƭƛ 

ǇǊŜőƛŎŀ ƴŀ ǘƛǇƪƻǾƴƛŎƛ /ǘǊƭ Ҍ !. 

 

¦abh¿!±!bW9 ¢9Y{¢! ¦NUTAR DOKUMENTA I IZa97¦ h¢±hw9bLI 

DOKUMENATA 

 

 Kopiraj / zalijepi (Copy / Paste): 

1. ƻȊƴŀőƛƳƻ ǘŜƪǎǘ ƪƻƧƛ ȌŜƭƛƳƻ ƪƻǇƛǊŀǘƛ 

2. ƪƻǇƛǊŀƳƻ ƻȊƴŀőŜƴƛ Řƛƻ ǘŜƪǎǘŀ ǇƻƳƻŏǳ ŀƭŀǘŀ Kopiraj (Copy)  (Ctrl + C) 

3. ǇƻǎǘŀǾƛƳƻ ǘƻőƪǳ ǳƳŜǘŀƴƧŀ ƴŀ ƳƧŜǎǘƻ ƎŘƧŜ ȌŜƭƛƳƻ ǎƳƧŜǎǘƛǘƛ ǘŜƪǎǘ 

4. ȊŀƭƛƧŜǇƛƳƻ ǘŜƪǎǘ ƴŀ ǘƻ ƳƧŜǎǘƻ ǇƻƳƻŏǳ ŀƭŀǘŀ Zalijepi (Paste)  (Ctrl + V) 

 YƻǇƛǊŀƴƧŜ ǇƻƳƻŏǳ metode uhvati ς vuci ς pusti (drag and drop) 

1. ƻȊƴŀőƛƳƻ ǘŜƪǎǘ ƪƻƧƛ ȌŜƭƛƳƻ ƪƻǇƛǊŀǘƛ 

2. ƴŀ ƻȊƴŀőŜƴƻƳ ǘŜƪǎǘǳ ǇǊƛǘƛǎƴŜƳƻ ƛ ȊŀŘǊȌƛƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ ǘŜ ǇǊƛǘƛǎƴŜƳƻ ƛ ȊŀŘǊȌƛƳƻ 

tipku Ctrl.  

3. ǾǳőŜƳƻ ǇƻƪŀȊƛǾŀő ƳƛǑŀ 

4. ƻǘǇǳǎǘƛƳƻ ǘƛǇƪǳ ƳƛǑŀ ƛ ǇƻǘƻƳ ǘƛǇƪǳ Ctrl. Tekst je zalijepljen na novu poziciju. 
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 LȊǊŜȌƛ κ ȊŀƭƛƧŜǇƛ ό/ǳǘ /  Paste): 

1. ƻȊƴŀőƛƳƻ ǘŜƪǎǘ ƪƻƧƛ ȌŜƭƛƳƻ ǇǊŜƳƧŜǎǘƛǘƛ 

2. ƛȊǊŜȌŜƳƻ ƻȊƴŀőŜƴƛ Řƛƻ ǘŜƪǎǘŀ ǇƻƳƻŏǳ ŀƭŀǘŀ LȊǊŜȌƛ (Cut)   (Ctrl +X) 

3. ǇƻǎǘŀǾƛƳƻ ǘƻőƪǳ ǳƳŜǘŀƴƧŀ ƴŀ ƳƧŜǎǘƻ ƎŘƧŜ ȌŜƭƛƳƻ ǎƳƧŜǎǘƛǘƛ ǘŜƪǎǘ 

4. ȊŀƭƛƧŜǇƛƳƻ ǘŜƪǎǘ ƴŀ ǘƻ ƳƧŜǎǘƻ ǇƻƳƻŏǳ ŀƭŀǘŀ Zalijepi (Paste)   (Ctrl + V) 

 tǊŜƳƧŜǑǘŀƴƧŜ ǇƻƳƻŏǳ metode uhvati ς vuci ς pusti (drag and drop): kao i kopiranje, ali bez 

tipke Ctrl 

 

 

Brisanje teksta slovo po slovo: tipka Delete ōǊƛǑŜ znak desno od kursora, a tipka BackSpace ōǊƛǑŜ Ȋƴŀƪ 

lijevo od kursora 

o ōǊȌƛ ƴŀőƛƴ brisanja - ƻȊƴŀőƛƳƻ ȌŜƭƧŜƴƛ Řƛƻ ǘŜƪǎǘŀ ƛ ǇǊƛǘƛǎƴŜƳƻ ǘƛǇƪǳ Delete 

 

 

thbL~¢!±!bW9 L½aW9b! ό¦b5hύ L thbL~¢!±!bW9 thbL~¢!±!bW! L½aW9NA (REDO) 

tƻƴƛǑǘƛ (Undo)     Ponovi (Redo)  

Pritiskom na strelicu ǇƻƪǊŀƧ ŀƭŀǘŀ ƻǘǾŀǊŀ ǎŜ ǇŀŘŀƧǳŏƛ ƛȊōƻǊƴƛƪ ǎŀ ǇƻǇƛǎƻƳ ǎǾƛƘ ŀƪŎƛƧŀ ƪƻƧŜ ǎƳƻ 

napravili. 

 

 

¦ǾƛƧŜƪ ǇǊǾƻ ƻȊƴŀőƛƳƻ ǘŜƪǎǘ Ǉŀ ƻŘŀōŜǊŜƳƻ ȌŜƭƧŜƴƛ ŀƭŀǘΣ  

strelica prema dolje pokraj alata daje dodatne opcije 
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IZBORNIK: DATOTEKA / FILE 

 
 

Stvaranje novog dokumenta: New > Blank document > /ǊŜŀǘŜ όǇǊŜőƛŎŀ ƴŀ ǘƛǇƪƻǾƴƛŎƛ Ctrl + N) 

 

hǘǾŀǊŀƴƧŜ ǇƻǎǘƻƧŜŏŜƎ ŘƻƪǳƳŜƴǘŀ - alatom Otvori / Open  όǇǊŜőƛŎŀ ƴŀ ǘƛǇƪƻǾƴƛŎƛ Ctrl + O) 

hǘǾŀǊŀƴƧŜ ǾƛǑŜ ƻŘ ƧŜŘƴƻƎ ŘƻƪǳƳŜƴǘŀΥ ǳȊ ǇƻƳƻŏ ǘƛǇƪŜ /ǘǊƭ ƛƭƛ {ƘƛŦǘ 

 

Alat Spremi (Save)  όǇǊŜőƛŎŀ ƴŀ ǘƛǇƪƻǾƴƛŎƛ Ctrl + S) 

 Spremi u / Save in - ǳ ƪƻƧǳ ƳŀǇǳ ŏŜ ǎŜ ŘƻƪǳƳŜƴǘ ǎǇǊŜƳƛǘƛ 

 Ime datoteke / File name - ǳǇƛǑŜƳƻ ƴŀȊƛǾ ŘŀǘƻǘŜƪŜ 

 Spremi kao tip / Save as type ς program u kojem spremamo dokument (MS Word .docx) 

 

hƭŀƪǑŀƴƻ ƧŜ ƪǊŜƛǊŀƴƧŜ ƴƻǾƻƎ ŘƻƪǳƳŜƴǘŀ ƪƻǊƛǑǘŜƴƧŜƳ ǇǊŜŘƭƻǑƪŀ ς ekstenzija .dotx 

 

Options > kartica Save > Save AutoRecover info every (odrediti ) 

 

Ispis / Print: 

 Printer ς ƻŘŀōƛǊŜƳƻ Ǉƛǎŀő 

 Page range: All ς sve Current page ς trenutna Pages ς odabir stranica 

 Copies ς broj kopija dokumenta 

 Collated ς ispisuje ǎŜ ŎƛƧŜƭƛ ŘƻƪǳƳŜƴǘ ƻŘ ǇƻőŜǘƪŀ Řƻ ƪǊŀƧŀΣ ŀ ȊŀǘƛƳ ǇǊŜƳŀ ȊŀŘŀƴƻƳ ōǊƻƧǳ 

kopija; Uncollated ς ispisuje se prva stranica prema zadanom broju kopija, zatim druga itd 

 Margins ς ƻŘ ƴŜƪƻƭƛƪƻ ǇƻƴǳŚŜƴƛƘ ǾŜƭƛőƛƴŀ ƳŀǊƎƛƴŀ ƻŘŀberemo jednu 

 Orijentacija / Orientation:  

o Portrait (vertikalan papir)  

o Landscape (horizontalan papir)   
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KARTICAΥ th29¢bL κ Iha9 

 
 

Vrsta slova (font): Times New Roman, Verdana, Ariel, Calibri (na slici) itd. 

±Ŝƭƛőƛƴŀ ǎƭƻǾŀ κ Cƻƴǘ {ƛȊŜ ς ǇŀŘŀƧǳŏƛ ƛȊōƻǊƴƛƪ    

 

Oblikovanje teksta:    

Podebljanje (Bold) 

- Ctrl + B 

½ŀƪƻǑŜƴƧŜ όLǘŀƭƛŎύ  

- Ctrl + I 

tƻŘǾƭŀőŜƴƧŜ ό¦ƴŘŜǊƭƛƴŜύ  

- Ctrl + U - ǘƛǇƪƻǾƴŀ ǇǊŜőƛŎŀ 

 

Primjena efekata (precrtavanje, indeksiranje, eksponiranje)  

 Precrtani tekst (Strikethrough) nekakav tekst 

 Indeks (Subscript)  H2O > H2O;  

 Eksponent (Superscript) 5 m2 > 5 m2 

Kliknemo na ǎƛǾǳ ǎǘǊŜƭƛŎǳ ǇƻƪǊŀƧ αCƻƴǘά  (ili ǇǊŜőƛŎŀ ƴŀ ǘƛǇƪƻǾƴƛŎƛ Ctrl + D) - ostali efekti koji se 

mogu primijeniti su: Dvostruko precrtano (Double Strikethrough), Sjena (Shadow), Kontura (Outline), 

Reljefno (Emboss), Ugravirano (Engrave), Smanjena velika slova (Small caps), Sve velika slova (All 

caps), Skriveni tekst je skriven pri ispisu (Hidden) 

 

Mala slova pretvoriti u velika ili obrnuto:  - VELIKA SLOVA / UPPERCASE  

- mala slova / lowercase 

Text Effects  - ǎŀŘǊȌƛ ƻǇŎƛƧŜ ƻōƭƛƪƻǾŀƴƧŀ teksta: Sjena / Shadow, Odsjaj / Reflection 

Text Highlight Color  - alat za isticanje teksta bojom 

{ƧŜƴőŀƴƧŜ κ {ƘŀŘƛƴƎ  - alat za bojanje pozadine teksta 

Obrubi / Borders  - ŀƭŀǘ Ȋŀ ǇƻǎǘŀǾƭƧŀƴƧŜ ǊŀȊƴƛƘ ǾǊǎǘŀ ƭƛƴƛƧŀ ƻƪƻ ƻȊƴŀőŜƴƻƎ ǘŜƪǎǘŀ 

.ƻƧŀƴƧŜ ǘŜƪǎǘŀ ǊŀȊƭƛőƛǘƛƳ ōƻƧŀƳŀΥ ŀƭŀǘ Cƻƴǘ /ƻƭƻǊ  

 

DǊŀŦƛőƪŜ ƛ ƴǳƳŜǊƛőƪŜ liste: 

DǊŀŦƛőƪŜ liste /  Bullets       bǳƳŜǊƛőƪŜ liste /  Numbering     

 umetanje ƴƻǾŜ ƻȊƴŀőŜƴŜ stavke ς 9ƴǘŜǊ ƴŀ ǘƛǇƪƻǾƴƛŎƛΣ ǇǊŜǎǘŀƴŀƪ ƻȊƴŀőŀǾŀƴƧŀ ς dva puta 

Enter 

 

Poravnanje teksta  

Poravnaj: lijevo / Align Left, po sredini / Centar, desno / Align Right, obostrano / Justify 
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Odabir proreda unutar odlomka - alat Line Spacing   

Prikazivanje i sakrivanje znakova koji nisu za ispis - Alat Show / Hide  

 

Stilovi: 

 primjena stila ς ƴŀƪƻƴ ƻȊƴŀőŀǾŀƴƧŀ ǘŜƪǎǘŀΣ ƪƭƛƪƴŜƳƻ ƴŀ ǇƻƴǳŚŜƴƛ ǎǘƛƭ κ ǎǘȅƭŜ 

o Ili pritisnemo  kod izbornika stilova > odaberemo stil > Primjeni stil / Apply Style  

 izmjena stila - pritisnemo  > Primjeni stil > Izmjeni (Apply Style > Modify)  

 iȊǊŀŘŀ ƴƻǾƻƎ ǎǘƛƭŀΥ ƻȊƴŀőƛƳƻ ǘŜƪǎǘ ǎŀ ȌŜƭƧŜƴƛƳ ƻōƭƛƪƻǾŀƴƧŜƳΣ ǇǊƛǘƛǎƴŜƳƻ  kod izbornika 

stilova > SǇǊŜƳƛ ƻȊƴŀőŜƴƻ ƪŀƻ ƴƻǾƛ ǎǘƛƭ κ {ŀǾŜ {ŜƭŜŎǘƛƻƴ ŀǎ ŀ bŜǿ vǳƛŎƪ {ǘȅƭŜ 

 

¢ǊŀȌŜƴƧŜ ƻŘǊŜŚŜƴŜ ǊƛƧŜőƛ ƛli fraze   

 bŀŚƛ κ CƛƴŘ, uǇƛǑŜƳƻ ŦǊŀȊǳΣ tǊƻƴŀŚƛ ǎƭƛƧŜŘŜŏŜ κ CƛƴŘ bŜȄǘ 

½ŀƳƧŜƴŀ ƻŘǊŜŚŜƴŜ ǊƛƧŜőƛ ƛƭƛ ŦǊŀȊŜ 

 Find What ς ƪƻƧǳ ǊƛƧŜő ǘǊŀȌƛƳƻ 

 Replace With - őƛƳŜ ȌŜƭƛƳƻ ȊŀƳƛƧŜƴƛǘƛ 

 

tǊŜƴƻǑŜƴƧŜ oblikovanja sa jednog dijela teksta na drugi - alat Format Painter  

tƻƳƻŏ ǳ a{ ²ƻǊŘǳ - alat Help  , F1 na tipkovnici  

 

 

KARTICA: UMETANJE / INSERT 

 
 

Prijelom stranice / Page Break  

 uklanjanje prijeloma: ǳƪƭƧǳőƛƳƻ {Ƙƻǿ κ IƛŘŜ, selektiramo oznaku Page Break, tipka Delete 

 

 

½ŀƎƭŀǾƭƧŜ ƛ ǇƻŘƴƻȌƧŜ (Header and Footer)   

 editiranje: ŘǾƻǎǘǊǳƪƛƳ ƪƭƛƪƻƳ ǳ ǇǊƻǎǘƻǊ ȊŀƎƭŀǾƭƧŀ ƛƭƛ ǇƻŘƴƻȌƧŀΤ ƛƭƛΥ pritisak na desnǳ ǘƛǇƪǳ ƳƛǑŀ ƛ 

odabir naredbe Uredi / Edit 

 ƛȊƭŀȊƛƳƻ ƛȊ ǇƻƭƧŀ ȊŀƎƭŀǾƭƧŀκǇƻŘƴƻȌƧŀΥ ŘǾƻǎǘǊǳƪƛ ƪƭƛƪ ƴŀ ǊŀŘƴǳ ǇƻǾǊǑƛƴǳ ŀǇƭƛƪŀŎƛƧŜ 

 

Umetanje polja (Quick Parts > Field...)  ƳƻȌŜƳƻ ǳƳŜǘƴǳǘƛΥ ōǊƻƧ ǎǘǊŀƴƛŎŜΣ ŘŀǘǳƳΣ 

vrijeme, autora/icu dokumenta itd. 
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Automatsko numeriranje stranica   

 Vrh stranice / Top of page,    

 Dno stranice / Bottom of page 

 te lijevi ili desni kut, ili sredina stranice  

 

Tablice  

 ǳƳŜǘŀƴƧŜ ǘŀōƭƛŎŜΥ ƳƛǑŜƳ ǇǊŜƭŀȊƛƳƻ ǇǊŜƪƻ ƪƻŎƪƛŎŀ őƛƳŜ ƻŘǊŜŚǳƧŜƳƻ ōǊƻƧ ǎǘǳǇŀŎŀ ƛ ǊŜŘŀƪŀΤ  

o ƛƭƛ ƻŘŀōŜǊŜƳƻ ƻǇŎƛƧǳ ¦ƳŜǘƴƛ ǘŀōƭƛŎǳ κ LƴǎŜǊǘ ¢ŀōƭŜ ƛ ǳǇƛǑŜƳƻ ōǊƻƧŜǾŜ  

 pǊƻƳƧŜƴŀ ǇƻƭƻȌŀƧŀ ǘƻőƪŜ ǳƳŜǘŀƴƧŀΥ ǘƛǇƪŀ ¢ab, tipke sa strelicama na tipkovnici, pritiskom 

lijeve tƛǇƪŜ ƳƛǑŀ ǳ ȌŜƭƧŜƴǳ ŏŜƭƛƧǳ 

 uǊŜŚƛǾŀƴƧŜ ǘŀōƭƛŎŜ: Table Tools > Obrubi / Borders 

Ҕ {ƧŜƴőŀƴƧŜ κ {ƘŀŘƛƴƎ  

 naknadno umetanje retka ili stupca: 

o ǘƻőƪǳ ǳƳŜǘŀƴƧŀ ǇƻȊƛŎƛƻƴƛǊŀƳƻ ǳ ŏŜƭƛƧǳ ƎŘƧŜ ȌŜƭƛƳƻ ǳƳŜǘƴǳǘƛ ǊŜŘŀƪ ƛƭƛ ǎǘǳǇŀŎΣ ǇǊƛǘƛǎƴŜƳƻ 

ŘŜǎƴǳ ǘƛǇƪǳ ƳƛǑŀ ǘŜ ƴŀ ōǊȊƻƳ ƛȊborniku odaberemo Umetni > red iznad (Insert > Row  

Above) ili ispod (Below)   

o ili Umetni > stupac lijevo (Insert > Column Left) ili desno (Right) 

 brisanje retka ili stupca 

o ƻȊƴŀőƛƳƻ ǊŜŘŀƪ ƛƭƛ ǎǘǳǇŀŎΣ ǇƻȊƻǾŜƳƻ ōǊȊƛ ƛȊōƻǊƴƛƪ ǘŜ ƛȊŀōŜǊŜƳƻ ƻǇŎƛƧǳ hōǊƛǑƛ ǎǘǳǇŎŜ 

ό5ŜƭŜǘŜ /ƻƭǳƳƴǎύ ƛƭƛ hōǊƛǑƛ ǊŜǘƪŜ ό5ŜƭŜǘŜ wƻǿǎύ 

o brisanje tablice: ƻȊƴŀőƛƳƻ ǘŀōƭƛŎǳ i pritisnemo tipku Delete  

 

Slike  

 ƻȊƴŀőŀǾŀƴƧŜ ǎƭƛƪŜ ǊŀŘƛƳƻ ǇǊƛǘƛǎƪƻƳ ƭƛƧŜǾŜ ǘƛǇƪŜ ƳƛǑŀ ƴŀ ȌŜƭƧŜƴƛ ƻōƧŜƪǘΣ ƴŀƪƻƴ őŜƎŀ ƻōƧŜƪǘ ƴŀ 

ƻōǊǳōǳ ŘƻōƛƧŜ ƪǾŀŘǊŀǘƛŏŜ 

 Ȋŀ ǇƻƳƛŎŀƴƧŜ ǎƭƛƪŜ ƴŀ ǇǊƻƛȊǾƻƭƧƴƻ ƳƧŜǎǘƻΥ ƻȊƴŀőƛƳƻ ǎƭƛƪǳΣ ŘŜǎƴŀ ǘƛǇƪŀ ƳƛǑŀ Ҕ CƻǊƳŀǘ tƛŎǘǳǊŜ Ҕ 

Layout > Wrap, odaberemo stil 

 pƻŘŜǑŀǾŀƴƧŜ ǾŜƭƛőƛƴŜ ƻōƧŜƪǘŀ 

o rǳőƴƻΥ ƻȊƴŀőƛƳƻ ƻōƧŜƪǘΣ ǇƻƳƛőŜƳƻ ƴŜƪŜ ƻŘ ǊǳōƴƛƘ ǘƻőŀƪŀ ƴŀ ƻƪǾƛǊǳ ƻōƧŜƪǘŀ 

o upisom vrijednosti: desni klik na objekt > Format Picture > kartica Size > unijeti vrijednosti 

Ȋŀ Ǿƛǎƛƴǳ όIŜƛƎƘǘύ ƛ ǑƛǊƛƴǳ ό²ƛŘǘƘύ 

 

Umetanje simbola    ϵ   ϻ   ϭ  қ  J  ґ  "  H  Y  ̂   »  Ï  Ĝ  itd. 

 

KARTICA: IZGLED STRANICE / PAGE LAYOUT 
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 aŀǊƎƛƴŜ κ aŀǊƎƛƴǎΥ ƻŘŀōŜǊŜƳƻ ǇƻƴǳŚŜƴŜ ƳŀǊƎƛƴŜ ǎ ƻōȊƛǊƻƳ ƴŀ ȌŜƭƧŜƴǳ ǾƛǎƛƴǳΣ ǑƛǊƛƴǳ 

 Orijentacija / Orientation: Portrait ς okomito postavljen papir; Landscape ς vodoravno 

postavljen papir, za tablice 

 ±Ŝƭƛőƛƴŀ κ Size - pƻŘŜǑŀǾŀƴƧŜ ŘƛƳŜƴȊƛƧŀ ǇŀǇƛǊŀ 

 Automatska funkcija Ȋŀ ǊŀǎǘŀǾƭƧŀƴƧŜ ǊƛƧŜőƛ /  Hyphenation  

o None (nikakva), Automatic, Manual 

 Obrub stranice / Page borders ς ǊŀȊƭƛőƛǘŜ ǾǊǎǘŜ ƛ ŘŜōƭƧƛƴŜ ƭƛƴƛƧŀ ƳƻƎǳ ōƛǘƛ ƻōǊǳō ƛ ŎƛƧŜƭƻƧ ǎǘǊŀƴƛŎƛ 

 Uvlaka / Indent - ǳǾǳőŜƴƻǎǘ ǊŜǘƪŀ 

 

KARTICAΥ th~¢! κ a!L[LbD{ 

 

{ƪǳǇƴƻ ǇƛǎƳƻΣ ǇƛǎƳƻ ǎ ƛǎǘƛƳ ǎŀŘǊȌŀƧŜƳ ƪƻƧŜ ǑŀƭƧŜƳƻ ƴŀ ǾƛǑŜ ŀŘǊŜǎŀ 

 Kreiranje: Start Mail Merge > Step by Step Mail Merge Wizard (kao na slici iznad) 

1) hŘŀōƛǊ ǾǊǎǘŜ ŘƻƪǳƳŜƴǘŀ ƴŀ ƪƻƧŜƳ ȌŜƭƛƳƻ ƪǊŜƛǊŀǘƛ ǎƪǳǇƴƻ ǇƛǎƳƻ 

Å Pismo ς tekst koji se razlikuje samo po umetnutim poljima  

Å Poruka e-ǇƻǑǘŜ ς kao i kod pisma 

Å Omotnice ς ispis imena i adrese primatelja 

Å Naljepnice 

Å Imenik ς cijeli dokument predstavlja ispis po poljima podataka iz baze podataka 

 

2) Odabir polaznog dokumenta 

Å ¦ǇƻǘǊƛƧŜōƛ ǘŜƪǳŏƛ ŘƻƪǳƳŜƴǘ ς dokument koji upravo koristimo 

Å tƻőƴƛ ƻŘ ǇǊŜŘƭƻǑƪŀ ς ƻŘŀōŜǊŜƳƻ ǇǊŜŘƭƻȌŀƪ 

Å PosǘƻƧŜŏƛ ŘƻƪǳƳŜƴǘ ς ƴŀǾƛƎƛǊŀƳƻ Řƻ ƛ ƻǘǾƻǊƛƳƻ ǇƻǎǘƻƧŜŏƛ ŘƻƪǳƳŜƴǘ 

 

3) Odabir primatelja 

Å YƻǊƛǎǘƛ ǇƻǎǘƻƧŜŏƛ ǇƻǇƛǎ ς koristimo imena i adrese iz datoteke ili baze podataka 

Å LȊŀōŜǊƛ ƳŜŚǳ ƪƻƴǘŀƪǘƛƳŀ ǳ hǳǘƭƻƻƪ-u / Select from Outlook contacts 

Å Utipkaj novi popis > kreiraj  / Type a new list > Create 

 

4) Organizacija svoje datoteke / Arrange your directory ς dodajmo informacije o 

primatelju: odredimo mjesto u dokumentu te kliknimo na jednu od stavki: Adresni 

blok, Pozdravi itd. 
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5) Pregled svoje datoteke / Preview your directory ς ǘŀƪƻŚŜǊ ƳƻȌŜƳƻ ǳǊŜŘƛǘƛ ǇƻǇƛǎ 

primatelja  

 

6) ½ŀǾǊǑŀǾŀƴƧŜ ǎƪǳǇƴƻƎ ǇƛǎƳŀ κ /ƻƳǇƭŜǘŜ ǘƘŜ ƳŜǊƎŜ 

 

KARTICA: PRIKAZ / REVIEW 

 
 

 ǊƛƧŜőƛ ƪƻƧŜ ǎǳ ƪǊƛǾƻ ǳǇƛǎŀƴŜ ōƛǘƛ ŏŜ ǇƻŘǾǳőŜƴŜ ŎǊǾŜƴƛƳΣ ǾŀƭƻǾƛǘƛƳ ƭƛƴƛƧŀƳŀ 

 pƻŘŜǑŜƴƧŀΥ wŜview > Language > Set Proofing Language 

 Alat Spelling and Grammar  - oǘǾŀǊŀ ǎŜ ŘƛƧŀƭƻǑƪƛ ƻƪǾƛǊ ǎŀ ƻǇŎƛƧŀƳŀΥ ƛƎƴƻǊƻǊŀƧ ƧŜŘƴƻƳΣ 

ignoriraj sve, promjeni, promjeni sve (Ignore once, Ignore all, Change, Change all) 

 ŀƪƻ ǎŜ ƴŜƪŀ ǊƛƧŜő ƴŜ ƴŀƭŀȊƛ ǳ ǊƧŜőƴƛƪǳ ǘŀŘŀ Ƨǳ ƳƻȌŜƳƻ ǳƴƛƧŜǘƛ ǳ ǊƧŜőƴƛƪ ƻȊƴŀőƛǾǑƛ ƧŜ Ҕ pritisak 

ŘŜǎƴŜ ǘƛǇƪŜ ƳƛǑŀ ƴŀŘ ƻȊƴŀőŜƴƻƳ ǊƛƧŜőƛ > Add to dictionary 

 

 

KARTICA: POGLED / VIEW 

 
 

 ǎƭƛƧŜŘŜŏƛ ŀƭŀǘƛ ǎŜ ƴŀƭŀȊŜ ǳ kartici Pogled/View  i u donjem desnom kutu aplikacije (na 

Statusnoj traci): 

o Print Layout - ƪŀƪƻ ŏŜ ǎŜ ƴŀ ƛǎǇƛǎƴƻƧ ǎǘǊŀƴƛŎƛ ǊŀǎǇƻŘƛƧŜƭƛǘƛ ǘŜƪǎǘ ƛ ǊŀȊƭƛőƛǘƛ ƻōƧŜƪǘƛΣ ƴŀƧőŜǑŏŜ 

ƪƻǊƛǑǘŜƴƛ ǇƻƎƭŜŘ 

o Full Screen Reading - ǇƻƎƻŘŀƴ Ȋŀ őƛǘŀƴƧŜ ŘƻƪǳƳŜƴǘŀ  

o Web Layout - pogled se koristi za izradu web stranice 

o Outline ς ǇƻƎƭŜŘ ƴŀ ǎǘǊǳƪǘǳǊǳ ŘƻƪǳƳŜƴǘŀΤ ƻƭŀƪǑŀƴ ǊŀŘ ǎŀ ǇǊŜƳƧŜǑǘŀƴƧŜƳΣ ƪƻǇƛǊŀƴƧŜƳΣ 

ǳǊŜŚƛǾŀƴƧŜƳ ǘŜƪǎǘŀ ǘŜ ǇǊƻƳƧŜƴƻƳ ƴƛǾƻŀ ƴŀǎƭƻǾŀ 

o Draft ς ǇƻƎƭŜŘ ƴŀ ŘƻƪǳƳŜƴǘ ƪŀƻ ƴŀ ƴŀŎǊǘΤ ƻŘǊŜŚŜƴƛ ŜƭŜƳŜƴǘƛ ƪŀƻ ƴǇǊΦ ȊŀƎƭŀǾƭƧŜ ǎŜ ƴŜ ǾƛŘƛ 

o Zoom ς ƻŘŀōƛǊ ǇƻƴǳŚŜƴŜ ƛƭƛ ǳƴƻǎ ǾǊƛƧŜŘƴƻǎǘƛ 

Page Width - ǇǊƛƪŀȊ Ǉƻ ǑƛǊƛƴƛ ǎǘǊŀƴƛŎŜ 

Text Width - ǇǊƛƪŀȊ Ǉƻ ǑƛǊƛƴƛ ǘŜƪǎǘŀ 

Whole Page ς ǇǊƛƪŀȊ őƛǘŀǾŜ ǎǘǊŀƴƛŎŜ 

Two Pages ς prikaz dviju stranica 
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Upotreba tabulatora 

 pritiskom na tipku TAB ƴŀ ǘƛǇƪƻǾƴƛŎƛΣ ǘƻőƪŀ ǳƳŜǘŀƴƧŀ ǎŜ ǇƻƳŀƪƴŜ Ȋŀ мΣнр ŎƳ ǳŘŜǎƴƻ 

 uǇƻǘǊŜōƻƳ ǘŀōǳƭŀǘƻǊŀΣ ƳƻȌŜƳƻ ǘƻőƴƻ ŘŜŦƛƴƛǊŀǘƛ ƎŘƧŜ ȌŜƭƛƳƻ Řŀ ǎŜ ǇƻƳŀƪƴŜ ǘƻőƪŀ ǳƳŜǘŀƴƧŀ 

 tabulatori:  

 - lijevi tabulator 

 - tabulator centriranja 

 - desni tabulator  

 - decimalni tabulator 
 

 ravnalo / Ruler treba biti vidljivo  

 ƛƪƻƴŀ ǘŀōǳƭŀǘƻǊŀ ǎ ƭƛƧŜǾŜ ǎǘǊŀƴŜ ǊŀǾƴŀƭŀ ƻƳƻƎǳŏǳƧŜ ƴŀƳ odabir vrste tabulatora 

 ƴŀ ȌŜƭƧŜƴǳ ǇƻȊƛŎƛƧǳ ƴŀ ǊŀǾƴŀƭǳ ǇǊƛǘƛǎƴŜƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ 

 tipkom TAB prelazimo od jednog do drugog tabulatora 

 ǳƪƭŀƴƧŀƴƧŜ ǘŀōǳƭŀǘƻǊŀΥ ǇǊƛǘƛǎƴŜƳƻ ƛ ȊŀŘǊȌƛƳƻ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ ƴŀ ƴƧŜƳǳ ǘŜ ǇƻǾǳőŜƳƻ ǇǊŜƳŀ 

dolje i potom otpustimo tipku ƳƛǑŀ 

 

  



ITdesk.info ς projekt raļunalne e-edukacije sa slobodnim pristupom 

ITdesk.info is licensed under a Creative Commons Attribution-  

Noncommercial-No Derivative Works 3.0 Croatia License.  11/12  

 

hǾŀ ǎƪǊƛǇǘŀ ƧŜ ƴŀƳƛƧŜƴƧŜƴŀ Ȋŀ ǳőŜƴƧŜ ǳȊ ƳŀǘŜǊƛƧŀƭŜ 

ƻōƧŀǾƭƧŜƴŜ ƴŀ ǎƭƛƧŜŘŜŏƛƳ ƭƛƴƪƻǾƛƳŀΥ 

 

 

ϝ tǊƛǊǳőƴƛƪΥ 

http://www.itdesk.info/prirucnik_obrada_teksta_microsoft_word_2010.pdf   

 

 

* Video prezentacije koje prikazuju rad u Microsoft Word 2010: 

 http://www.itdesk.info/hrvatski/microsoft-word-1/ 

 http://www.itdesk.info/hrvatski/microsoft-word-2/ 

 http://www.itdesk.info/hrvatski/microsoft-word-3/ 

 http://www.itdesk.info/hrvatski/microsoft-word-4/ 

 

 

* Probni ispit:  

http://www.itdesk.info/primjeri ispita/primjer ispita modul 3.pdf  

 

 

* Video-ǇǊŜȊŜƴǘŀŎƛƧŀ ƪƻƧŀ ǇǊƛƪŀȊǳƧŜ ǊƧŜǑŀǾŀƴƧŜ ǇǊƛƳƧŜǊŀ ƛǎǇƛǘŀΥ 

http://www.itdesk.info/hrvatski/obrada-teksta-microsoft-word-2010-video-rjesenje-ispita/  

 

 

ϝ YǾƛȊŜǾƛ ƪƻƧƛ ƪƻǊƛǎƴƛŎƛκŎŜ ǎŀƳƛ ǊƧŜǑŀǾŀƧǳΥ 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-1/ 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-2/ 

 http://www.itdesk.info/hrvatski/obrada-teksta-kviz-3/ 

 

 

(za otvaranjŜ ƭƛƴƪŀ ƪƻƧƛ ǎŜ ƴŀƭŀȊƛ ǳƴǳǘŀǊ ΦǇŘŦ ŘƻƪǳƳŜƴǘŀ ǎŀƳƻ ǇǊƛǘƛǎƴƛǘŜ ƭƛƧŜǾǳ ǘƛǇƪǳ ƳƛǑŀ ƴŀ 

ƧŜŘŀƴ ƻŘ ƴŀǾŜŘŜƴƛƘ ƭƛƴƪƻǾŀΦ ²Ŝō ǎǘǊŀƴƛŎŀ ƴŀ ƪƻƧǳ ƭƛƴƪ ǇƻƪŀȊǳƧŜ ŏŜ ǎŜ ƻǘǾƻǊƛǘƛ ǳ LƴǘŜǊƴŜǘ 

ǇǊŜƎƭŜŘƴƛƪǳ ƪƻƧŜƎ ƛƳŀǘŜ ƛƴǎǘŀƭƛǊŀƴƻƎ ƴŀ ǊŀőǳƴŀƭǳΦύ 

  

http://www.itdesk.info/prirucnik_obrada_teksta_microsoft_word_2010.pdf
http://www.itdesk.info/hrvatski/microsoft-word-1/
http://www.itdesk.info/hrvatski/microsoft-word-2/
http://www.itdesk.info/hrvatski/microsoft-word-3/
http://www.itdesk.info/hrvatski/microsoft-word-4/
http://www.itdesk.info/primjeri%20ispita/primjer%20ispita%20modul%203.pdf
http://www.itdesk.info/hrvatski/obrada-teksta-microsoft-word-2010-video-rjesenje-ispita/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-1/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-2/
http://www.itdesk.info/hrvatski/obrada-teksta-kviz-3/
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hǇŏƛ ǳǾƧŜǘƛ ƪƻǊƛǑǘŜƴƧŀΥ 

Web stranicu www.ITdesk.info je pokrenula udruga ĂOtvoreno druġtvo za razmjenu 

ideja - ODRAZIñ u sklopu aktivnog promoviranja ljudskog prava na slobodan 

pristup informacijama te ljudskog prava na edukaciju. 

Slobodno kopirajte i distribuirajte ovaj dokument, uz uvjet da ne mijenjate niġta u 

njemu! 

 

Nad svim programima i uslugama navedenim na web stranici ITdesk Home na web adresi ITdesk.info 
ƛǎƪƭƧǳőƛǾƻ pravo posjeduju njihovi autori/ce. Microsoft, Windows, i Windowsxx ǎǳ ǊŜƎƛǎǘǊƛǊŀƴƛ ȊŀǑǘƛǘƴƛ 
ȊƴŀƪƻǾƛ ǘǾǊǘƪŜ aƛŎǊƻǎƻŦǘ /ƻǊǇƻǊŀǘƛƻƴΦ hǎǘŀƭƛ ȊŀǑǘƛǘƴƛ ȊƴŀŎƛ ƪƻǊƛǑǘŜƴƛ ƴŀ L¢ŘŜǎƪ IƻƳŜ ²Ŝō ǎǘǊŀƴƛŎŀƳŀ 
ǎǳ ƛǎƪƭƧǳőƛǾƻ ǾƭŀǎƴƛǑǘǾƻ ƴƧƛƘƻǾƛƘ ǾƭŀǎƴƛƪŀκŎŀΦ ¦ƪƻƭƛƪƻ ƛƳŀǘŜ ǇƛǘŀƴƧŀ ǾŜȊŀƴŀ ǳȊ ǳǇƻǊŀōǳ ƛƭƛ ǊŜŘƛǎǘǊƛōǳŎƛƧǳ 
bilo kojeg programa, molƛƳƻ ƪƻƴǘŀƪǘƛǊŀƧǘŜ ŀǳǘƻǊŜκƛŎŜ ŘƻǘƛőƴƻƎ ǇǊƻƎǊŀƳŀΦ {Ǿŀ ŘƻŘŀǘƴŀ ǇƛǘŀƴƧŀ 
ǇƻǑŀƭƧƛǘŜ na info@itdesk.info.  

hǾŜ ǿŜō ǎǘǊŀƴƛŎŜ ǎŀŘǊȌŀǾŀƧǳ ƭƛƴƪƻǾŜ ƴŀ ƻǎǘŀƭŜ ǿŜō ǎǘǊŀƴƛŎŜ ƛƭƛ ƛȊǾƻǊŜΦ L¢ŘŜǎƪΦƛƴŦƻ ǘŜŀƳ bLW9 
odgovoran za tekstualni iκƛƭƛ ǊŜƪƭŀƳƴƛ ǎŀŘǊȌŀƧΣ ƻŘƴƻǎƴƻ Ȋŀ ǇǊƻƛȊǾƻŘŜ ƪƻƧƛ ǎǳ ƴŀ ǘƛƳ ǿŜō 
ǎǘǊŀƴƛŎŀƳŀκƛȊǾƻǊƛƳŀ ǇƻƴǳŚŜƴƛΣ ƪŀƻ ǎǘƻ bLW9 ƻŘƎƻǾƻǊŀƴ ƴƛǘƛ Ȋŀ ǎŀŘǊȌŀƧ ƪƻƧƛ ƧŜ ǇǳǘŜƳ ƴƧƛƘ ŘƻǎǘǳǇŀƴΤ 
ƳƻƎǳŏƴƻǎǘ ƪƻǊƛǑǘŜƴƧŀ ƛƭƛ ǘƻőƴƻǎǘ ǎŀŘǊȌŀƧŀΦ [ƛƴƪƻǾŜ ƪƻǊƛǎǘƛǘŜ ƴŀ Ǿƭŀǎǘƛǘǳ ƻŘƎƻǾƻǊƴƻǎǘΦ ¢ŀƪƻŚer, 
ITdesk.info team ne garantira: 

 Řŀ ƧŜ ǎŀŘǊȌŀƧ ƴŀ ƻǾƛƳ ǿŜō ǎǘǊŀƴƛŎŀƳŀ ƻǎƭƻōƻŚŜƴ ƻŘ ǇƻƎǊŜǑŀƪŀ ƛƭƛ ǇƻƎƻŘŀƴ Ȋŀ ǎǾŀƪǳ ǎǾǊƘǳΣ 

 Řŀ ŏŜ ƻǾŜ ǿŜō ǎǘǊŀƴƛŎŜ ƛƭƛ ǿŜō ǳǎƭǳƎŜ ŦǳƴƪŎƛƻƴƛǊŀǘƛ ōŜȊ ǇƻƎǊŜǑŀƪŀ ƛƭƛ ǇǊŜƪƛŘŀΣ 

 Řŀ ŏŜ ōƛǘƛ ƻŘƎƻǾŀǊŀƧǳŏƛ Ȋŀ ǾŀǑŜ ǇƻǘǊŜōŜΣ 

 da implementacija ǘŀƪǾƻƎ ǎŀŘǊȌŀƧŀ ƴŜŏŜ ƴŀǊǳǑŀǾŀǘƛ ǇŀǘŜƴǘŜΣ ŀǳǘƻǊǎƪŀ ǇǊŀǾŀΣ ȊŀǑǘƛǘƴƛ Ȋƴŀƪ ƛƭƛ 
ƻǎǘŀƭŀ ǇǊŀǾŀ ƴŜƪŜ ǘǊŜŏŜ ǎǘǊŀƴŜΦ 

¦ƪƻƭƛƪƻ ǎŜ ƴŜ ǎƭŀȌŜǘŜ ǎ ƻǾƛƳ ƻǇŏƛƳ ǳǾƧŜǘƛƳŀ ƪƻǊƛǑǘŜƴƧŀ ƛƭƛ ŀƪƻ ƴƛǎǘŜ ȊŀŘƻǾƻƭƧƴƛ ǿŜō ǎǘǊŀƴƛŎŀƳŀ ƪƻƧŜ 
ǇǊǳȌŀƳƻΣ ǇǊŜƪƛƴƛǘŜ ǎ ƪƻǊƛǑǘŜƴƧŜƳ ƻǾƛƘ ǿŜō ǎǘǊŀƴƛŎŀ ƛ ǿŜō ǳǎƭǳƎŀΦ L¢ŘŜǎƪΦƛƴŦƻ ǘŜŀƳ ƴƛƧŜ ƻŘƎƻǾƻǊŀƴ 
ǾŀƳŀΣ ƴƛǘƛ ǘǊŜŏƛƳ ƻǎƻōŀƳŀ Ȋŀ ōƛƭƻ ƪƻƧǳ ƴŀǎǘŀƭǳ ǑǘŜǘǳΣ ōƛƭŀ ƻƴŀ ŘƛǊŜƪǘƴŀΣ ƛƴŘƛǊŜƪǘƴŀΣ ǎƭǳőŀƧƴŀ ƛƭƛ 
ǇƻǎƭƧŜŘƛőƴŀΣ ǇƻǾŜȊŀƴŀ ǎ ƛƭƛ ǇǊƻƛȊƭŀȊŜŏŀ ƛȊ ǾŀǑŜ ǳǇƻǊŀōŜΣ ǇƻƎǊŜǑƴŜ ǳǇƻǊŀōŜ ƻǾƛƘ ǿŜō ǎǘǊŀƴƛŎŀ ƛƭƛ ǿŜō 
ǳǎƭǳƎŀΦ Lŀƪƻ ǾŀǑŜ ǇƻǘǊŀȌƛǾŀƴƧŜ ƳƻȌŜ ōƛǘƛ ōŀȊƛǊŀƴƻ ƴŀ ƎŀǊŀƴŎƛƧƛΣ ǳƎƻǾƻǊǳΣ ǇǊŜƪǊǑŀƧǳ ƛƭƛ ƴŜƪƻƳ ŘǊǳƎƻƳ 
ǇǊŀǾƴƻƳ ǳǇƻǊƛǑǘǳΣ neovisno o ƴŀǑƻƧ ƻōŀǾƛƧŜǑǘŜƴƻǎǘƛ ƻ ƳƻƎǳŏƴƻǎǘƛ ƴŀǎǘŀƴƪŀ ǘŀƪǾŜ ǑǘŜǘŜΣ ƻǎƭƻōŀŚŀƳƻ 
ǎŜ ǎǾŀƪŜ ƻŘƎƻǾƻǊƴƻǎǘƛΦ tǊƛƘǾŀŏŀƴƧŜ ƻƎǊŀƴƛőŜƴƧŀ ƴŀǑŜ ƻŘƎƻǾƻǊƴƻǎǘƛ ƴǳȌŀƴ ƧŜ preduvjet ƪƻǊƛǑǘŜƴƧŀ ƻǾƛƘ 
web stranica i web usluga. 

Svi softveri navedeni u ovom ili drugim dokumentima objavljenim na stranici ITdesk.info su navedeni 

samo za edukativne svrhe ili kao primjer te mi, ƴŀ ōƛƭƻ ƪƻƧƛ ƴŀőƛƴΣ ne preferiramo navedeni softver u 

odnosu na neki drugi softver. Bilo koju izjavu da neki navedeni softver ǇǊŜŦŜǊƛǊŀƳƻ ǾƛǑŜ ǳ ƻŘƴƻǎǳ ƴŀ 

drugi, koji se spominje ili ne spominje u materijalima, ǎƳŀǘǊŀǘ ŏŜ ǎŜ kao ƭŀȌƴƛ ƛǎƪŀȊ. bŀǑǳ ƛȊǊŀǾƴǳ ƛ 

ōŜȊǊŜȊŜǊǾƴǳ ǇƻŘǊǑƪǳ ƛƳŀƧǳ ƧŜŘƛƴƻ ǎƻŦǘǾŜǊƛ ƻǘǾƻǊŜƴƻƎ ƪƻŘŀ όƻǇŜƴ ǎƻǳǊŎŜύ ƪƻƧƛ ƻƳƻƎǳŏǳƧǳ 

korisnicima/cama Řŀ ōŜȊ ǇǊŜǇǊŜƪŀ Ǉƻǎǘŀƴǳ ŘƛƎƛǘŀƭƴƻ ǇƛǎƳŜƴƛΣ ƪƻǊƛǎǘŜ Ǌŀőǳƴŀƭƻ ƛ ǎǳŘƧŜƭǳƧǳ ǳ 

ƳƻŘŜǊƴƻƳ ƛƴŦƻǊƳŀǘƛőƪƻƳ ŘǊǳǑǘǾǳΦ  
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